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Welcome to Mac OS 8

Mac OS 8 sets the standard for personal computers. Mac OS 8 features a
beautiful, more responsive interface that will help you to work smarter and
faster. It includes all the features and services you need to harness the power
of the Internet quickly and easily. And with Mac OS 8, it has never been
easier to install, configure, and manage your system.

System requirements
To install Mac OS 8, your computer must have
m a PowerPC™ or 68040 (including the 68LC040) microprocessor
m at least 8 MB of RAM (16 MB recommended)
Note: Computers that are upgraded with a PowerPC or 68040 processor card
but still have 68030 (or earlier) processors that are accessed during startup
are not supported.
To use Mac OS 8 a computer must have at least 8 MB of RAM (randomaccess memory). If your computer has less than 16 MB of built-in RAM, you
must use virtual memory. (Mac OS 8 automatically turns on virtual memory
when you install it.) To use the Internet applications provided with Mac OS 8,
your computer must have at least 20 MB of RAM, either built-in or by using
virtual memory.
If you don’t know how much RAM your computer has, choose About This
Computer (or About This Macintosh) from the Apple menu (K). Check the
number next to Built-in Memory.
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To install the recommended software, you need about 95 MB of free space on
your hard disk. To install the optional components, you need about 110 MB of
disk space. The exact amount of space needed varies for different computer
models, hard disk sizes, and the optional software you choose to install.
To check the amount of hard disk space you have, open your hard disk icon.
Then choose the icon or small icon view from the View menu and check the
number just below the window’s title bar. (The number has the words “MB
available” after it.)
Tip: Many application programs use your hard disk to temporarily store
information, so it’s a good idea to keep at least 10 percent of your disk space
free. For best performance, you should recheck the amount of available disk
space after installing Mac OS 8.

Where to begin
This manual tells you how to install Mac OS 8. Read the information below
to determine how to get started installing the software.
m If you bought Mac OS 8 in order to upgrade your system software, start
with Chapter 2, where you’ll learn how to install the upgrade.
m If this book came with your new computer, you might already have
Mac OS 8 installed. If it is, start with Chapter 3.
If you’re not sure if Mac OS 8 is already installed on your computer, follow
these steps to find out:
1

Turn on your computer.

2

Open the Apple (K) menu and choose About This Computer.

3

Look at the system software version reported in the window.

m If the window on your computer has a smiling face, Mac OS 8 is already
installed. (The number next to the face is the version number.) Skip ahead
now to Chapter 3 to learn how to configure your computer.
m If the system software version number is less than 8.0, you can use your
computer with the system software it has, or you can install Mac OS 8 right
now to get started with the newest technology. When you’re ready, turn to
Chapter 2 for instructions.
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Installing Mac OS 8

Read this chapter for instructions on installing Mac OS 8. The installation
will replace the operating system your computer currently has, but will not
affect your documents or applications.

Before you install Mac OS 8
Before you begin the installation, do the following:
m Turn off any disk-security software you may have.
m If At Ease software is installed on your computer, turn it off before you

install Mac OS 8. For instructions, see the manual that came with your
At Ease software or computer.
m Shut down your computer and restart it using the Mac OS 8 disks. See
“Starting Up From the Mac OS 8 Disks,” later in this chapter.
WARNING PowerTalk is not compatible with Mac OS 8. Installing

Mac OS 8 disables PowerTalk. If you use PowerTalk, see “Installing
Over PowerTalk” in Chapter 6 before continuing with the installation
process.

3

If you have a PowerBook
If you are installing Mac OS 8 on a PowerBook, do the following additional
steps:
m Plug the PowerBook in and set it so it doesn’t go to sleep.
m Turn off password protection in the Password Security control panel.
You can install Mac OS 8 using a CD-ROM drive attached to (or built into)
your PowerBook, or you can use the Mac OS 8 installation disks. Or, if you
also have a desktop Mac OS computer, you can use it to install Mac OS 8 on
your PowerBook using this method:
m Connect both your PowerBook and your desktop computer to an AppleTalk
or another available network. Put the Mac OS 8 CD in the drive of your
desktop computer, then use File Sharing to access the CD with your
PowerBook over the network. Be sure to run the Install Mac OS 8 program
from your PowerBook, so that the Installer can detect the model of
PowerBook you’re using.
Note: Installing Mac OS 8 on a PowerBook in SCSI disk mode is not
recommended. With SCSI disk mode, the Installer can’t detect the
PowerBook, and will default to installing software for the model of desktop
computer you’re using. You could perform a universal installation, but this
won’t install the optimal set of software for your model of PowerBook.
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Starting up from the Mac OS 8 disks
You should start up your computer using the Mac OS 8 CD-ROM disc or
floppy disks. That way, the installation program can repair any problems on
your hard disk and update the disk driver before it installs the software.

If you have the Mac 0S 8 floppy disks
To start up your computer with the Mac OS 8 floppy disks, follow these steps:
1

Shut down your computer.

2

Insert the Install Me First disk into the computer’s floppy disk drive.

3

Turn on your computer.

The installation program starts automatically. See the section “Installing the
Software,” later in this chapter.

If you have the Mac OS 8 CD-ROM disc
To start up your computer with the Mac OS 8 CD, follow these steps:
1

Insert the Mac OS 8 CD in your computer’s CD-ROM drive.

2

Shut down your computer.

3

Turn on your computer while holding down the C key on your keyboard.

Your computer starts up from the CD-ROM disc. Continue holding down the
C key on your keyboard until you see the screen with the smiling face. If you
have a PowerBook 1400, you’ll need to hold down the x (Command), Option,
Shift, and Delete keys instead of the C key.
If you have trouble starting up from the CD-ROM disc, see “Problems During
Installation” in Chapter 6.
You’ll know you’ve started up with the CD-ROM disc if you see the CD-ROM
disc icon at the top-right corner of the desktop, above your hard disk icon.
When you’ve successfully started up with the CD, turn to the section
“Installing the Software.”
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If you can’t start up with the CD
If you don’t have an Apple-brand CD-ROM drive, or you’re accessing the CD
from your PowerBook using File Sharing, you won’t be able to start up from
the CD, but you can still install the software that’s on it.
To ensure a smooth installation, turn off any virus-protection software you
have installed.
If you are using System 7.5 or later, open the Extensions Manager control
panel and choose “System 7.5.x base” (or 7.6.x base) in the Sets pop-up menu.
Then restart the computer.
If you are using an earlier version of system software, or don’t have the
Extensions Manager, do the following:
1

Open the System Folder, then open the Extensions folder.

2

Drag any non-Apple extensions out of the Extensions folder and onto the desktop.

If you don’t know where a particular extension came from, click it once to
select it, then choose Get Info from the File menu. If the Version area of the
Get Info window doesn’t say “Apple Computer, Inc.,” drag the extension to
the desktop.
3

Open the Control Panels folder.

4

Drag any non-Apple control panels out of the Control Panels folder and onto the desktop.

As mentioned in step 2, use the Get Info command if you’re not sure whether
to remove a control panel.
5

Restart your computer.

After you’ve finished installing the software, you can drag the extensions and
control panels back to your System Folder. For now, it’s important to remove
them to avoid any conflicts they may cause when installing the software.
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Installing the software
After you’ve started your computer using the CD-ROM disc or floppy disk,
use the Mac OS Installer program to install the software.
m If you’re installing from the CD, double-click the Install Mac OS 8 icon.
m If you are installing from the floppy disk, the Installer opens automatically
when you start up your computer with the disk in the drive.
After a moment, a screen appears describing the four steps in the
installation process.

Click to display
more information
about each step.

The Mac OS Installer guides you through the steps necessary to install the
software. To learn more about each step, click the Help button (h) in the
upper-right corner of the window.
When you’re ready to begin, click Continue. Follow the instructions you see
onscreen. Refer to the rest of this section if you need more information about
what you see on your screen.

Reading late-breaking news
Be sure to read the important information displayed by the Installer. Since the
onscreen information was written later than this manual, it contains the latest
news about installing Mac OS 8.

Installing Mac OS 8

7

Selecting which software to install
The Mac OS Installer installs the basic components of the system software.
In step 4 of the installation process, you can select which software you want
to install in addition to the basic system software. If you’re installing from the
Mac OS 8 CD, the following choices are available:
m Mac OS Runtime for Java, for using programs written in the Java™
computer language.
m Personal Web Sharing, to share documents using the World Wide Web.
m QuickDraw 3D, to view and manipulate 3D images. Your computer must
have a PowerPC microprocessor to use QuickDraw 3D.
m OpenDoc, to take advantage of software written for the OpenDoc
environment.
m MacLink Plus, to easily open Mac OS, DOS, and Windows documents
created in applications you don’t have, using applications you do have.
These translators work with the Mac OS Easy Open control panel.
m Apple Location Manager, a utility for quickly switching between different
settings on your PowerBook computer.
m Cyberdog, an application for accessing the Internet. You must also install
OpenDoc to use Cyberdog.
m QuickDraw GX, to use programs with advanced graphics and typography
features.
m Text-to-Speech, to have your computer read text and alert messages aloud.
m Apple Remote Access, to connect to a remote Mac OS computer, such as
your computer at work, using a modem. The computer you connect to
must have the Apple Remote Access Server software installed.
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Responding to messages about your hard disk
The Mac OS Installer checks the destination hard disk for errors before
installing the software. Additionally, if your hard disk was formatted with an
Apple disk utility program, the Installer updates the hard disk drivers with the
latest version of the driver software. If your drives are formatted with a disk
utility from another company, the drivers are not updated. You should use the
third-party disk utility to update your hard disk before installing Mac OS 8.
If there are errors during these procedures, you will see messages on your
screen. See “Problems During Installation” in Chapter 6 for help.
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After Installing Mac OS 8

After you install Mac OS 8 and restart your computer, the Mac OS Setup
Assistant appears. The assistant asks you a series of questions, then configures
your computer using the information you provided. See “Using the Mac OS
Setup Assistant” in this chapter for more information.
After you’ve been using Mac OS 8 for a while, you might decide that you
want to add software that you didn’t initially choose to install, or you might
want to remove software that you’re not using. See “Adding or Removing
Software” in this chapter for more information.

Using the Mac OS Setup Assistant
1

If necessary, open the Mac OS Setup Assistant.

If you’ve just installed Mac OS 8, the assistant appears onscreen when you
restart your computer. Or, you can open it yourself by double-clicking its icon
in the Assistants folder on your hard drive.
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2

Read the introduction then click the arrow at the bottom-right corner of the window.

You can also navigate to the next window by holding down the x key and
pressing the right arrow key.
As you continue with the Mac OS Setup Assistant, you’ll be asked to provide
information about yourself, your location, and the settings you want for your
computer. For example, you can enter your name, the current date and time,
and the type of Apple printer you have connected to your computer.

Adding or removing software
The customize option in the Mac OS Installer allows you to add or remove
components of Mac OS 8.
Follow the instructions in this section if you want to
m reinstall all or part of Mac OS 8
m add software products you didn’t initially choose to install
m remove some software installed with Mac OS 8
m install additional basic components, such as printer drivers
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1

Start up from the Mac OS 8 disks and open the Mac OS Installer program.

Refer to the instructions in Chapter 2 for details about these steps.
If you’ve previously installed Mac OS 8 on the destination drive, the Installer
asks if you want to reinstall Mac OS 8, or if you want to add or remove
software you select.

2

Choose an option.

m If you want to reinstall the basic system software, click Reinstall. This is
the same as installing Mac OS 8 for the first time. See “Installing the
Software,” in Chapter 2, for instructions.
m If you want to add new software, or remove software you have installed,
click Add/Remove. Then follow the steps below.
Note: Your screen may look slightly different from the one pictured below. If
you’re installing from floppy disks, you won’t see all the choices available on
the CD.
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3

Select the software to install, or the software to remove, or both.

As you proceed in the custom installation process, you’ll be able to determine
exactly which components will be installed or removed for the software you
select.
4

Click Start.

If you see messages about problems with your hard disk, see “Problems During
Installation” in Chapter 6.
The Installer for the first software product you selected appears. You’ll use
the Installer to specify which components of the product you want to install.
5

When you see the Installer’s welcome screen, click Continue.

If you want all the recommended components for this product, click Install.
Then skip ahead to step 9.
If you want to install specific components of the software, or remove the
software, follow steps 6–8 below.
6

Open the pop-up menu and choose a menu item.

m If you want to install software, choose Custom Install.
m If you want to remove software, choose Custom Remove.

14

Chapter 3

All available components for the software product appear in the
Installer’s window.

7

Scroll through the list of components and click the checkbox next to each component
you want to install or remove.

You can see and select individual items within each component by clicking
the arrow to the left of the component, then clicking the item you want to
install. To get additional information about each component listed, click the
box with the letter i in it to the right of the component.
8

Click Install or Remove.

If you are installing software, the selected items will be installed on your
computer. If you are removing software, the selected items will be deleted
from your computer.
In either case, the Installer may also remove or delete associated files that are
required for the items you choose.
If you have problems while installing, see “Problems During Installation” in
Chapter 6.
9

Repeat steps 5–8 for all the software you selected.

After you finish installing or removing a software product, the Installer for
the next product you selected opens automatically.
10

After you’ve installed all the software you selected, restart your computer.

If you can’t restart the computer, see “Problems Using Mac OS 8” in Chapter 6.
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Accessing the Internet

Mac OS 8 comes with software to help you set up and connect to the Internet.
This chapter describes what you can do on the Internet and how to set up
your computer to access the Internet.

What is the Internet?
The Internet is a loosely knit federation of computer networks that “speak”
the same language. The language is a communications standard known as
the Internet protocol, or IP. The Internet gives you access to a wide variety
of services and information. Some of the most widely used Internet
services include
m electronic mail (e-mail) to exchange messages with other Internet users
m the World Wide Web to access information from all over the world,
including text, color images, music, animation, QuickTime movies, and
virtual reality scenes
m newsgroups (public discussion groups)
m file transfer protocol (FTP) to transfer files to or from other computers on
the Internet
Once you are connected to the Internet, you will be able to get the latest
software updates for your computer, read about new products, participate in
user group discussions, and provide feedback to technical support.
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What's the difference between the Internet and online services?
An Internet service provider lets you connect your computer to the Internet
through a modem and phone line. What you can do on the Internet once you
are connected depends upon the software you have on your computer. See the
Mac OS Info Center on your hard disk for information about the Internet
software supplied with Mac OS 8.
Online services, such as America Online (AOL) and CompuServe, also
require you to connect through a modem and a phone line, but they provide
special content and services available only to their members. Though most
online services allow access to the Internet, members may not necessarily
have access to the full range of Internet information and services. Software for
accessing America Online is on the Mac OS 8 CD.

What you need to connect to the Internet and use your software
To connect to the Internet you need the following:
m A modem capable of transmitting data at 14,400 baud (28,800 baud or
higher recommended) connected to an analog telephone line, or direct
Internet access through a local area network.
m 20 MB of RAM. If your computer does not have 20 MB of RAM, then you
must turn on virtual memory and set it to at least 20 MB. Choose Help
from the Help menu on your computer and then select Virtual Memory
from the Index for more information about using virtual memory.
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Setting up your computer to access the Internet
If you are new to the Internet and need to set up access through a modem,
you will first need to register with an Internet service provider. Follow the
instructions in the next section, “Registering With an Internet Service Provider.”
If you already have an account established with an Internet service provider
and want to continue using that account, or if you want to set up access
through a local area network (LAN), skip to the section “Adding or Modifying
an Internet Configuration.”
If you are an Apple Internet Connection Kit (AICK) user, see the section
“Upgrading From the Apple Internet Connection Kit,” later in this chapter.
Note: If you plan to use an online service, such as America Online or
CompuServe, contact the online service for instructions on establishing an
account. Software for America Online is available on the Mac OS 8 CD.

Registering with an Internet service provider
To connect to the Internet with a modem, you need to establish an account
with an Internet service provider, or ISP. The Internet Setup Assistant
connects you to a registration server that lets you compare ISPs and register
with one of them. Have your credit card handy and be prepared to write down
some important information your service provider gives you. Then follow the
steps below.
Note: The registration feature is available only in the U.S. and Canada.
Canadian customers should read the Internet Access for Canada file in the
Internet Access in Canada folder located in the Internet Extras folder on your
hard disk or Mac OS 8 CD before using the Internet Setup Assistant.
1

Open the Internet Setup Assistant by double-clicking its icon, located in the Assistants
folder on your hard disk.

The Internet Setup Assistant window opens.

Accessing the Internet
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2

Click Register.

Read the introduction and then click the right arrow located at the bottom of
the window.
You can also move to the next window by holding down the x key and
pressing the Right Arrow key.
3

Follow the onscreen instructions and type the appropriate information on each screen.

You are asked to provide the following information:
m personal information, such as your name and phone number
m information about the modem you are using
Your computer dials the phone and connects to the Netscape Registration
Server. It then launches a World Wide Web browser. Once the browser opens,
you see the Netscape Internet Account Server window which lists Internet
service providers for your region. The screen you see may not look exactly
like this one:

`

4

Follow the onscreen instructions for selecting an Internet service provider and for
establishing a dial-up Internet account.

Note: The ISP you select may not have dial-up access available in your local
area. Check the phone numbers carefully to be sure you won’t be accruing
long-distance or toll charges when you use the service.
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5

Write down the important information about your account and about your provider, such
as your e-mail address and the provider’s support number.

Keep the information you’ve written down in a safe place.
Do not store your password where anyone else can access it. For best
security, choose a password that has numbers as well as uppercase and
lowercase letters.
6

Complete the steps for creating an account, then click Configure.

The Netscape Registration Server sends information about your new account
to your computer. Your Web browser quits automatically, and the Internet
Dialer window appears.
7

Choose your new ISP from the Connect Via menu.

8

Click Connect to use your new account.

If you do not want to connect to your new account now, choose Quit from the
File menu.
Congratulations! You now have an Internet account.

Accessing the Internet
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Adding, modifying, or removing an Internet configuration
You use the Internet Setup Assistant to add, modify, or remove Internet
service provider or LAN information. You may first need to contact your
Internet service provider or your network administrator to get details about
your Internet service provider account.
1

Open the Internet Setup Assistant by double-clicking its icon, located in the Assistants
folder on your hard disk.

The Internet Setup Assistant window opens.
2

Click Update.

Read the introduction and then click the arrow located at the bottom right of
the Introduction window.
3
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Select the appropriate action, then click the right arrow to continue.

4

Follow the onscreen instructions and type the appropriate information on each screen.

You are asked to provide the following information:
m a name for your configuration
m a static IP address or a protocol for dynamic configuration
If your dynamic configuration is MacIP, select a MacIP zone where the IP
server is located.
If you are using a static IP address, you are asked to provide a subnet mask
and router address. You may need to ask your network administrator for
these values.
m one or more domain name servers (DNS)
m a domain name
m your e-mail address
m your e-mail password
m the e-mail account—the name of the remote computer that receives your
e-mail, also called a Post Office Protocol (POP) account
m the e-mail host—the name of the computer that processes your outgoing
mail, usually called the Simple Mail Transfer Protocol (SMTP) host
m the newsgroup host—the name of the remote computer that provides you
with the Internet news service (Usenet) using Network News Transfer
Protocol (NNTP). (Entering this information is optional.)
Consult your network administrator or Internet service provider if you do not
know the appropriate information for your computer.

Setting your preferences for connecting
You use the Internet Setup Utility to choose applications, documents, or files
you want to open automatically after connecting to the Internet, and to select
your active ISP or LAN connection. You can also import Internet
configurations that you used before upgrading to Mac OS 8.
To choose applications or change default settings, do the following:
1

Open the Internet Utilities folder located in the Internet folder on your hard disk.
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2

Double-click the Internet Setup Utility icon.

The Internet Setup Utility window opens.
3

Select the appropriate action.

If you select Add, a dialog box appears
that lets you select the applications or
documents you want opened.
You may want to import or export
settings if you are changing computers
or upgrading your Mac OS.
You may remove settings that are no
longer used.

You can launch the Internet Setup Assistant to
add, modify, or remove your configurations.

Connecting to the Internet
If you use a modem, your computer is set to dial automatically into your
Internet service provider when an application that requires an Internet
connection is used. If you are connected to a LAN, your computer connects
automatically to the Internet when you launch an Internet application such as
Claris Emailer™ Lite.
If you turn off the auto-dial option in the PPP control panel, or you have
more than one Internet configuration (such as two ISP accounts or an ISP
account and a LAN connection) you use the Internet Dialer to connect.
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Follow these steps to use the Internet Dialer:
1

Open the Internet folder on your hard disk.

2

Double-click the Internet Dialer icon.

3

Choose the connection you want to use from the Connect Via menu.

4

Click Connect.

Once a connection is established, the Connect button changes to Disconnect.
You can use this button to disconnect from the Internet when you are done.
See the section “Disconnecting From the Internet,” next.
You can view the Internet Dialer window to keep track of how long you’re
connected to the Internet.
5

Once you are connected, open the Internet application that you want to use (such as
Netscape Navigator or Claris Emailer Lite).

Disconnecting from the Internet
If you use a modem, don’t forget to disconnect from the Internet. Quitting an
application program won’t automatically hang up the phone. When you quit
an application such as Netscape Navigator™ or Claris Emailer, you are still
connected to the Internet, and you will accrue connection time and
potentially be charged for that time.
Your computer is set to disconnect your modem after ten minutes of network
inactivity. You can adjust the amount of inactive time needed to trigger an
automatic disconnect, or turn off this option, in the PPP control panel.
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To disconnect when using a modem:
1

Quit each of the Internet applications you have open.

2

Click on the Internet Dialer window to make it active.

If the Internet Dialer is not already open, double-click its icon located in the
Internet folder on your hard disk.
3

Choose Disconnect.

To disconnect when connected through a LAN, do this:
m Quit each of the Internet applications you have open.

Once you have quit Internet applications such as a Web browser and an email program, you will be disconnected from the Internet. You do not need to
do anything else.

Upgrading from the Apple Internet Connection Kit
After installing Internet Access for Mac OS 8, your AICK preferences are
converted automatically after restarting your computer. If you used a connect
script in AICK to connect to your Internet service provider, see the section
“Importing Connect Scripts,” next.

Importing connect scripts
You may need to import a connect script if either of the following is true:
m Your Internet service provider requires you to use a connect script.
m You are upgrading from AICK to Internet Access for Mac OS 8, and you
used a connect script in AICK.
Before you follow these steps, be sure the connect script that you want to
import is on your hard disk. Then follow these steps:
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1

Choose PPP from the control panel menu.

If your user name and password, and your ISP’s phone number do not appear
in the PPP control panel, enter them now.

2

Click Options and then click the Protocol tab.

The Protocol window appears.

3

Click the checkbox next to “Connect to a command-line host.”

4

Click the “Use terminal window” button, then click OK.

The PPP control panel reappears.
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5

Click Connect.

The PPP Terminal window appears after the modem has made a connection.

6

Click Settings.

The PPP Terminal Settings window appears.
7

Click the checkbox next to “Prompt to save Connect Script on close.”

Make sure “Close Terminal when PPP is started” is also checked.
8

Click OK.

The PPP Terminal window reappears.
9

Enter the appropriate information at each prompt.

You are asked for information such as your user name and password. If you
don’t know all the information, contact your Internet service provider.
Once you have entered the appropriate information, click Continue.
10

Enter a name for your connect script, then click Save.

Once your script is saved, the PPP control panel reappears.
11
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Click Disconnect in the PPP control panel, and then click Options.

12

Click the “Use connect script” button, and then click Import Script.

A dialog box appears.

13

Select your connect script and click Open.

Your connect script is the file you saved in step 10. Once you click Open, the
Protocol window reappears.
14

Click OK.

The PPP control panel reappears.
15

Close the PPP control panel.

A dialog box appears; click Save.
You may now connect to this Internet service provider. See the section
“Connecting to the Internet,” earlier in this chapter.
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Learning About Mac OS 8

Mac OS 8 includes many new features and enhancements. The Mac OS Info
Center is a new onscreen reference for information about the Mac OS. You
can use the Info Center to find out what’s new and how to get the most out of
the features of Mac OS 8.

Using the Mac OS Info Center
1

Double-click the Mac OS Info Center icon on your desktop.

If you’re asked to locate a Web browser, choose one of the programs shown
in the dialog box. If you don’t have a browser on your computer, install the
Internet applications provided with Mac OS 8. See “Adding or Removing
Software” in Chapter 3.
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The Mac OS Info Center uses a Web browser, such as Netscape Navigator, to
display its information. Your computer must have enough memory to load a
Web browser, but it does not need to be connected to the Internet in order to
use the Mac OS Info Center. Most of the files are stored on your hard disk.

2

To begin, click Show Me What I Can Do.

3

On the “Discovering What You Can Do” page, click “What’s New in the Mac OS.”

Click a topic area to read about the new Mac OS features in that category.
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Where to find help
The Info Center is just one of the places you can look for information about
using Mac OS 8. Refer to these other valuable sources of information about
using your computer.

Onscreen help
The Help menu is your main source of “how to” information about the
Mac OS. Many application programs also have onscreen help.
To view onscreen help, switch to the program you want to use, then look in
the Help menu.

Late-breaking news
If you have questions about compatibility or other late-breaking news about
your software, refer to the “Read Me” documents in the Mac OS Read Me
Files folder on your hard disk and the Mac OS 8 CD-ROM disc.

If you’re connected to the Internet, be sure to also check the “late-breaking
news” information link in the Info Center.

Learning about Mac OS 8
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On the Internet
Visit Apple’s home page on the World Wide Web. You’ll find links to a large
number of resources, including technical support and product information.
For information about the Internet software included with Mac OS 8, see the
Internet resources supplied by the manufacturers of the software.

34

Chapter 5

Software

WWW address

Aladdin StuffIt

http://www.aladdinsys.com

Apple Computer, Inc.

http://www.apple.com

Apple Live Home Page

http://livepage.apple.com

Apple QuickTime

http://quicktime.apple.com

Adobe Acrobat

http://www.adobe.com

Claris Emailer Lite

http://www.claris.com

Live Audio

http://www.emerald.net/liveaudio/default.htm

Macromedia Shockwave

http://www.macromedia.com

Netscape Navigator

http://www.netscape.com
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Troubleshooting

If you encounter problems when installing Mac OS 8, read this chapter for
some common solutions.

Problems during installation
This section helps you solve problems you may encounter while installing
your software.
You can’t start up the computer using the Mac OS 8 CD-ROM disc or the Mac OS 8 Install
Me First disk.

Cause: Your computer located the system software on your hard disk before it
located the system software on the CD or floppy disk. If you have an external
hard drive with system software, the computer may locate and boot from that
device instead of the CD-ROM disc.
Solution: With the CD or floppy disk inserted, open the Startup Disk control
panel and click the CD or floppy disk icon. Then restart the computer.
You’ll need to reselect your hard disk as the startup disk after you install the
software. Open the Startup Disk control panel again and click the icon for
your hard disk. Then restart your computer.
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The Installer cannot repair your hard disk.

Cause: The Mac OS Installer is unable to repair your problem.
Solution 1: If you see a message that the disk can’t be fixed because a
file is open, quit all programs. If file sharing is on, turn it off. Then try
installing again.
Solution 2: Use a third-party disk repair utility to see if it can repair the disk.
If you don’t have a third-party utility, or if that utility can’t repair the disk
either, you may need to reinitialize the hard disk.
First, back up your hard disk because reintializing erases everything on the
disk. Then use the Drive Setup utility program to reinitialize the disk. If your
hard disk is not an Apple hard disk, use the disk utility software provided by
the manufacturer instead of Drive Setup.
You can find Drive Setup in the Utilities folder on the Mac OS 8 CD-ROM
disc, or on the Disk Tools floppy disk. To reinitialize your startup disk (the disk
with system software on it) you need to start up the computer from a different
disk. You can start up using the Mac OS 8 CD-ROM disc or Disk Tools floppy
disk. See “Starting Up From the Mac OS 8 Disks” in Chapter 2 for
instructions.
After you’ve reinitialized the disk, use the Mac OS 8 Installer to reinstall
system software, then reinstall your application programs.
For more information about reinitializing your hard disk, see the manuals that
came with your computer.
The Installer cannot update the hard disk driver.

Cause 1: You don’t have an Apple-brand hard disk or you don’t have an
Apple-brand computer.
Solution 1: Use the disk utility recommended by the manufacturer of your
computer or hard disk to update the drivers on your system before installing
Mac OS 8. Make sure to get the latest version of the utility from the
manufacturer. An old utility will not be able to update your disk with the most
current driver. If you have a Zip drive, you can update the driver for it using
the software in the Iomega Tools folder, in the CD Extras folder, on the
Mac OS 8 CD.
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Cause 2: You’ve previously updated your Apple hard disk with a non-Apple
disk utility.
Solution 2: You need to use the utility you used previously to update the driver
again. To ensure a successful update, obtain the latest version of the utility.
Cause 3: Some hard disks must be reinitialized before you can update the
driver.
Solution 3: Back up all the files on the hard disk, then use Drive Setup to
reinitialize the hard disk. For instructions on reinitializing the hard disk, see
the manual that came with your computer, but use Drive Setup provided with
Mac OS 8 to perform the initialization, even if another Apple program was
supplied with your computer.
You see a message that there’s not enough memory to use the Installer.

Cause 1: You didn’t start up the computer using the Mac OS 8 CD-ROM disc
or floppy disk.
Solution 1: See “Starting Up From the Mac OS 8 Disks” in Chapter 2.
Cause 2: You have too many applications open.
Solution 2: Quit all open application programs.
Cause 3: You have too many system extensions running.
Solution 3: If you have system software version 7.5 or later, open the
Extensions Manager control panel and choose “System 7.5.x base” (or 7.6.x
base) from the Sets menu; then restart the computer. If you have an earlier
version of system software, hold down the Shift key while you restart the
computer. This turns off all system extensions.
Cause 4: Your disk cache or RAM Disk setting is set too high in the Memory
control panel.
Solution 4: Open the Memory control panel, set your disk cache to the lowest
possible setting, and reduce or turn off your RAM disk. Then restart the
computer.
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You see a message that your computer doesn’t have enough memory to use
the software.

Cause: Your computer has less RAM than is required to use Mac OS 8.
Solution: For memory guidelines, see “System Requirements” in Chapter 1. If
necessary, contact your computer dealer for information about how to
purchase additional memory.
You see a message that there’s not enough disk space.

Cause: Your computer’s hard disk has less than the minimum amount of
space required to install the software.
Solution: Make more space available on your hard disk by removing some
files from the disk. Make backup copies of the files, if desired. Then drag
them to the Trash icon and choose Empty Trash from the Special menu. You
don’t need to quit the Installer before you remove files from the disk.
When you see this message, some of the software you selected may have been
successfully installed. The Install Software window in the Installer program
indicates which software has already been installed. (When you quit the
Installer, the list of software already installed is no longer available.)
You see a message that the System file cannot be modified.

Cause 1: You have installed virus-protection software that guards against
modification of the System file.
Solution 1: Start up your computer from the Mac OS 8 CD-ROM disc or
floppy disk, as described in “Starting Up From the Mac OS 8 Disks” in
Chapter 2.
Solution 2: Drag any virus-protection software out of the System Folder and
restart your computer. You can put the virus-protection software back after
installation.
Cause 2: The System and Finder files may be locked.
Solution 2: To see if your System file or Finder file is locked, select the file’s
icon. Then open the File menu and choose Get Info. To unlock the file, click
the Locked checkbox to remove the mark.
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You see a message that the installation was not successful.

Cause: You may have an incompatible item in your System Folder.
Solution 1: Start up your computer using the Mac OS 8 CD-ROM disc or the
floppy disk. See “Starting Up From the Mac OS 8 Disks” in Chapter 2.
Solution 2: If you have a non-Apple CD-ROM drive and can’t start up from
the CD, try restarting your computer with only those extensions provided with
your version of system software.
m If you are using System 7.5 or later, you can open the Extensions Manager
control panel and choose “System 7.5.x base” (or 7.6.x base) in the Sets
pop-up menu. Then restart the computer.
m If you are using an earlier version of system software, drag any non-Apple
extensions out of your Extensions folder and onto the desktop, then restart
the computer. (If you don’t know where a particular extension came from,
select its icon. Then choose Get Info from the File menu. Apple extensions
all have “© Apple Computer, Inc.” in the Version section of the Get Info
box.)

Problems using Mac OS 8
This section helps with problems you may encounter using the computer after
you have installed Mac OS 8.
You can’t start up or restart the computer, or when you do you see a bomb message.

Cause 1: You probably have an incompatible item in the System Folder.
Solution 1: Follow the instructions in “Resolving Software Conflicts,” later in
this chapter.
Cause 2: Your system software may have been damaged.
Solution 2: Follow the instructions in “Performing a Clean Installation,” later
in this chapter, to reinstall system software.
Application programs freeze, or require you to restart the computer.

Cause: You may have an incompatible item in the System Folder or the
application program is incompatible with Mac OS 8.
Solution: Follow the instructions in “Resolving Software Conflicts,” later in
this chapter.
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For compatibility information on application programs, contact the program’s
manufacturer. You may have a version of the program that doesn’t work with
Mac OS 8.
None of your network devices appear in the Chooser.

Cause 1: AppleTalk is not turned on.
Solution 1: Make sure AppleTalk is turned on in the Chooser and that the
correct port is selected in the AppleTalk control panel. If AppleTalk is turned
on, make sure you have chosen the correct port in the “Connect via” pop-up
menu in the AppleTalk control panel.
Cause 2: There is a conflict between your network number and another
network number.
Solution 2: If your network number or node number has been set to “User
Defined,” turn off the User Defined setting in the AppleTalk control panel.
Then close and reopen the control panel.
For complete AppleTalk setup instructions, see Mac OS Help, available in the
Help menu when the Finder is active.
You can’t connect to devices outside your local network.

Cause: Your router address or subnet mask hasn’t been entered correctly.
Solution: Make sure your router address and subnet mask are entered
correctly in the TCP/IP control panel. Check with your network administrator
or Internet service provider for the correct values to enter.
For complete TCP/IP setup instructions, see Mac OS Help, available in the
Help menu when the Finder is active.
You notice visual inconsistencies or odd appearance in some programs.

Cause: Some programs are not compatible with the new appearance of
Mac OS 8.
Solution: These cosmetic problems will not affect the way the programs
work, but if the inconsistencies bother you turn off the system-wide
appearance checkbox in the Appearance control panel. Contact the
manufacturer of the program to see if an updated version is available.
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Resolving software conflicts
If your computer does not start up properly or behaves erratically, you
probably have an incompatible extension, control panel, or application.

Step 1: Verify the problem
To verify that you have a compatibility problem, follow the steps below.
1

Start up your computer while holding down the Space bar.

Holding down the Space bar opens the Extensions Manager control panel
during startup.
2

Release the Space bar when the Extensions Manager control panel opens.

3

Open the Selected Set menu and choose Mac OS 8 base System.

This turns off all extensions and control panels except those installed with
Mac OS 8.
4

Close the Extensions Manager control panel to continue startup.

5

When the computer is ready, try the same actions that caused the problem.

If the problem no longer occurs, you probably have an extension or control
panel that doesn’t work with Mac OS 8. Continue with the steps in “Step 2:
Test Individual Extensions and Control Panels” to identify the item that is
causing the problem.
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If the problem still occurs, try checking your hard disk for problems with the
Disk First Aid utility. You can find Disk First Aid in the Utilities folder on the
Mac OS 8 CD or on the Disk Tools floppy disk. You should also check to make
sure that your application programs are compatible with Mac OS 8. If the
problem occurs only when using a certain program, that program is probably
not compatible. Check with the program’s manufacturer for information.

Step 2: Test individual extensions and control panels
To test an individual extension or control panel for compatibility, follow the
steps below.
1

Start up your computer while holding down the Space bar.

Holding down the Space bar opens the Extensions Manager control panel
during startup.
2

Release the Space bar when the Extensions Manager control panel opens.

3

Turn on the item you want to test by clicking its checkbox.

4

Close the Extensions Manager to continue startup.

5

Try the same actions that caused the problem.

If the problem does not occur again, then the item is probably compatible
with Mac OS 8.
If the problem occurs again, the item is probably incompatible. Open the
Extensions Manager control panel and click the item’s name to turn off the
checkbox.
6

Repeat steps 1 through 5 for each item you want to test.

If you find that a piece of software is incompatible, turn it off or remove it
from your computer, then contact the manufacturer of the software to see if
an updated version is available.
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Performing a clean installation
This section provides instructions for what is commonly called a clean
installation of system software.
A normal system software installation replaces changed system files and adds
new ones, but leaves other files alone. When you install system software using
a clean installation, the Installer creates a new System Folder on your hard
disk. The old System Folder is renamed Previous System Folder. Since your
computer has a new System Folder, you must reinstall any third-party
extensions and control panels after a clean installation. Application programs
and documents are not replaced or changed.
Performing a clean installation can be a complicated procedure, but if you are
experiencing problems or your computer seems slow, it may help.
If your computer came with software that was already installed, some of those
programs might need to be reinstalled after you perform a clean installation.
See the manuals that came with your computer for information.
Follow these steps to perform your clean installation.
1

Start up your computer from the Mac OS 8 CD-ROM disc or from the Mac OS 8 Install Me
First disk, as described in “Starting Up From the Mac OS 8 Disks” in Chapter 2.

2

Open the Mac OS Installer application.

3

In the Welcome dialog box, click continue.

The Select Destination dialog box appears.
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4

Click the Perform Clean Installation checkbox so that it has a mark in it.

5

Click Select.

6

Select the software products you want to install.

For more information about the choices available, or for instructions on
further customizing your selections, see Chapter 3.
7

Click Start to install the software you’ve selected.

A new System Folder is installed on your hard disk. (The old System Folder is
renamed Previous System Folder.)
When the Mac OS Installer is finished, you can reinstall extensions, fonts,
control panels, and other items not installed with Mac OS 8 from their
original disks. If you don’t have the original disks, you can drag these items
one at a time from the Previous System Folder to the new System Folder.
Restart your computer after you reinstall each item, to make sure the software
is compatible with Mac OS 8.
After you’re sure that you’ve copied all the items you want to save into your
new System Folder, delete the Previous System Folder from your hard disk.

Problems setting up Internet access
The list of modem types in the Modem Settings window does not include the name of
your modem.

Solution: Copy the modem script file (CCL) supplied with your modem into
the Modem Scripts folder in the Extensions folder. Additional modem scripts
are available in the CD Extras folder on the Mac OS 8 CD. If you can’t find a
script for your modem, contact the manufacturer of the modem to get this file.
Once the file is copied into the Modem Scripts folder, your modem will
appear as a choice the next time you launch the Internet Setup Assistant.
You have an internal modem, but the Modem Port menu in the Modem Settings window
does not include Internal Modem as a choice.

Solution: If your computer has an internal modem, but it does not appear as a
choice, then Modem Port is the correct selection.
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Your modem appears in the list of modem types in the Modem Settings window, but your
modem does not seem to be working.

m Check to see that your modem is turned on and connected to your
computer and to your phone line correctly.
m You may need to contact the modem vendor to get an updated modem
script. Once you get this script, copy it into the Modem Scripts folder in
the Extensions folder located in your System Folder.

Problems creating an Internet account or connecting
While you are attempting to create a new account, the line seems to have dropped or you
get no response from the computer your modem has called.

Solution: When you try to create an account, the ISP Setup Assistant places a
call to an Internet registration server and launches a World Wide Web
browser. If you experience problems at that point, you must quit the Web
browser. If you see a dialog box that asks you if you want to continue, click
Continue. Sometimes the remote computer is busy temporarily and you can
try to create the account again almost immediately.
You cannot connect to an online service using the Internet Setup Assistant.

Cause: The Internet Setup Assistant is designed to connect your computer to
an Internet service provider. It is not designed for use with online service
providers such as America Online or CompuServe.
Solution: Contact the online service for software and instructions on how to
set up an account with them. America Online software is provided on the
Mac OS 8 CD.
You see a “Trouble with Assistant” window when you attempt to connect.

m Check to see that the correct port is selected for your modem, and that
your modem is turned on and connected properly to your computer and to
an analog phone line.
m Your modem initialization string may not be working correctly. You may
need to contact the modem vendor to get an updated modem script.
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You cannot set up Internet access through a LAN and you used BootP or DHCP with
your previous version of the Mac OS.

Solution: You need to use the TCP/IP control panel to configure your Internet
access manually. Choose Help from the Help menu on your computer for
information about the TCP/IP control panel.

Problems with your World Wide Web browser
The following problems may occur when you use the Internet Setup
Assistant. See the documentation for your World Wide Web browser or
contact the manufacturer of the browser directly for assistance and
troubleshooting information.
Your Web browser “freezes” (doesn’t respond to input from the keyboard or mouse)
whenever it’s opened.

Cause: You may need to increase the amount of RAM available to
this application.
Solution 1: If your computer does not have 20 MB of RAM, then you must
turn virtual memory on so that your RAM and virtual memory total at least
20 MB. For more information see the Memory topic in the onscreen help,
available in the Help menu on your computer.
Solution 2: If you have at least 20 megabytes of RAM, you may need to quit
other applications that you have running, and you may need to increase the
amount of RAM available to your browser by using the Get Info command.
For more information see the Memory topic in the Help menu on
your computer.
You see a message saying “This server does not have a DNS entry.”

Cause: The server that you are attempting to access may be shut down or not
operating correctly.
Solution 1: Since the situation may only be temporary, try connecting at
another time.
Solution 2: If you typed the URL (uniform resource locator) of the
destination page, check to be sure that you’ve typed it correctly. You may have
omitted a letter or used incorrect capitalization.
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The Netscape Navigator plug-ins you were using before you installed Mac OS 8 are no
longer working.

Cause: When Mac OS 8 was installed, a new Netscape Navigator folder was
created in the Internet Applications folder located in the Internet folder on
your start up disk.
Solution: You must move your plug-ins to the plug-in folder located in this
Netscape Navigator folder.
You see a message that your browser is “unable to create a network socket connection.”

Cause: Your connection to the Internet may have closed.
Solution 1: Check the status on the Internet Dialer. You may need to connect
to the Internet again.
Solution 2: In some cases, you may need to quit and restart your browser.

Installing over PowerTalk
PowerTalk is not compatible with Mac OS 8. Once you install Mac OS 8, you
will not be able to use PowerTalk services, including
m your PowerTalk keychain
m personal catalogs
m your PowerTalk mailbox
m the AppleMail application program
m digital signatures
m PowerShare server mail and services
After you install Mac OS 8, you no longer see your mailbox and keychain
icons. You see your personal catalogs, but you won’t be able to open them.
Additionally, you can only access AppleMail messages that were saved as text
files and moved out of your PowerTalk mailbox before you installed Mac OS 8.
To save your messages as text files, follow these steps:
1

Open a PowerTalk mail message.

2

Open the File menu and choose Save As Text.

3

In the dialog box that appears, choose a name for the message.
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4

Choose a location in which to store the text message.

You can save the file in any folder on your hard disk.
Tools to help save and convert your PowerTalk information are available on
the World Wide Web at the following address:
http://devworld.apple.com/dev/powertalk/
If you have Internet access, use these tools before you install Mac OS 8.
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